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1.0 NEW GIS FEATURES 

1.1 Overview 

There are a number of new features within V15 C1k and above, which enables users to 
download (a snap shot in time of the GIS data) and import this information into 12d, including 
attributes, Rasters, line work etc 

These options are still under development and 12d is working on extending the GIS import 
interface.  

The features are free for those on maintenance  

 

1.2 Different GIS Options 

• There are a number of new importation options with v15, as shown in the screen shot 
below 

File > GIS  

 

  

 

2. New Importation Options 

1. Revised GIS Menu 
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1.3 Required Files 

As this is a new feature between a major version release, number of files need to be coped 
into the 12d folder User folder, these are contained within a zip folder, which can be 
downloaded here. 

Files in the 2User, and 2User_Lib folders need to be copied in to your respective $User 
folders. 

 

 

Styles – 12d NZ has created a number of new symbols for the GIS import, which 
need to be copied into the $User/Styles folder and the $User/ user_symbols.4d file 
need to be edited  to add the following lines ( the first two might already be within the 
file). Otherwise, the supplied chain will not run and provide a number of error when 
applying the mapfile. 

 

#include  "Styles\Xtra_symbols_12dNZ.4d" 

#include  "Styles\Xtra_symbols_drainage.4d" 

#include  "Styles\Xtra_symbols_MetaConnex.4d" 

#include  "Styles\Xtra_symbols_LINZ_WFS.4d" 

 

• Images – As V15 uses the concept of Theme’s, this does require copying the 
supplied icons (all of the different sizes) into the correct images folders. 

 

 

 

• Toolbar  - A new GIS tool bar has been created to speed up the import process for 
the different work flows, these are linked to the suppled example chains 

User need to add supplied file contained within the 2User/Toolbars folder AND add 
the following line to the $User/user_toolbars.4d file 

#include  "Toolbars\Xtra_GIS_Import.4d" 

 
 
 

https://remote.12dsynergy.co.nz/12dSpublished/9a023b26-0fb4-481e-8e77-10315ce4cf6d
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View >Toolbars > GIS Import 

 

 
 
 
 

 

 

 
 
 
 

 

If you can't see the images within the toolbar above, please see the section 

on images folder location 
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2.0  LINZ DATA SERVICES (LDS) WEBSITE  

Access 

Before beginning, users will need to create a login within the LINZ Data Services (LDS) 
website. This is free to do; just requires an email account. 

 

Accessing the LDS website  

 

Creating a LINZ Data Services Website API Key 

Only registered users of the LDS can create API keys, most layers can be access via a 
single API key. 

LINZ has created a guide to the API keys  

 

Once you have created your key, if you are logged into LDS and select a web service URL, 
your web service key is automatically populated in the URL for you to easily copy and paste 
into your application. 

 

Entering the API Key into the WFS 12d chain 

 

Ever company/user needs to add their own API Key into the LINZ_LDS_WFS.chain,  

The quickest option is editing the file within Notepad ++ 

Using Notepad++ 

Open the $User_Lib folder, file need to be edited 

GIS_LINZ_LDS_WFS.pvf  

You need to replace the XXXXXXX with the LDS API key and then save the file 

 

 

 

 

 

https://data.linz.govt.nz/
https://www.linz.govt.nz/guidance/data-service/linz-data-service-guide/web-services/creating-api-key
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2.1 LINZ Data Services Website Workflow 

 

Historically, most new projects have two options to bring boundary information into 12d, 
either via a Land on Line XML or a file from the LINZ Data services website (for example a 
CAD, Raster or Shapefile). 

The new LINZ WFS option, allows 12d users to directly consume published layers from the 
LDS website, which also includes attribute data (something that was not available when 
importing a CAD file) and then the user can apply an Attribute Manipulator file or an Attribute 
label mapfile.  

 

Selecting a Layer within LINZ Data Services Website 

Once the user has signed into the LDS website and created an API key, they can search 
layers as normal within the LDS Website. Under the Data Tab, the user can select the layer 
box to view more information about the different layer’s features   

 

Using the LINZ Data Service Website, the user has the option of viewing a single layer or all 
of the available layers  

 

 

 

 

 

 

 Select required LDS Layer to view 
the layer options 
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Location Polygon  

 
12d does require a predefine polygon which is used within the search of the GIS system, the 
user needs to create a polygon which covers required location. 
 
 

Enter the Projection details 

As the LINZ Data services and most GIS system store the data within NZTM, but surveyors 
work in the different local circuits, the user will need to set the projection within 12d, the first 
icon on the GIS Toolbar set the projection within12d. 

 

 

LDS has the option of Change Sets 

A changeset outlines what has been added, updated or deleted in a 

particular dataset. You can use a changeset to update your data without 

having to download the entire dataset from scratch. 

A changeset contains an additional “change” attribute, describing whether a 

row has been inserted, updated or deleted. 

 

  This option has not been implemented within 12d yet 

 

The user can select a 
single layer or ALL the 
WFS layer that can be 
search within 12d 

Select the Services and 
API Tab 

List of the Different 
API Keys 
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Make sure to select the NZGD Projections, as these contain the EPSG code 

that the GIS system uses to reproject into the correct coordinate system  
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Importing a LINZ WFS Layer into 12d 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select  LINZ WFS 
Data Services 
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The LDS website contains a large amount of information and multiple 

layers that look the same, BUT the attribute information is different. 

 

 

Enter the API Key 

Select the 
Dropdown Arrow to 
view the different 
Layers 

 

Select Read to 
Import the Dataset 

Select The 
project 
projection 
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The Spatial Tab  
 

 
 
 

 
 
 
 
 

 
 

LINZ WFS Importation Chain 

Currently, the import process is a single layer at a time, this limitation, is perfect for creating a 
processing chain. 
 
Within the $USER_LIB there is an example chain, that can be customised for your needs. In 
the supplied Example, the chain only imports three layers, this can be edited to import more 
layers, but copying an existing command and the editing the path to the required Layer, by 
using the Option Manual Command 

 

 

Every time the user selects the different layers, 12d will go to the LDS to 

request the information. 

Depending on your internet connection speed, this could take from a few 

second to a minute. 

 

 

There are a number of different Spatial Operators that have 
been defined within a GIS system, Section 8.8.5.1 of the help 
guide goes into detail of the different options 

For Most users, selecting the “Within” Operator will work in 
most situations. Ie import all the information on a layer that 
contained within a Boundary Polygon 
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The chain uses parameters to pass a user entered extents of import (Polygon) down to the 
different layers, therefore saving the user the need to keep reselecting the area 

 

 
 

Chain Process  

The chain runs a step-by-step process to import the data into 12d. 
 

• User must enter the LINZ API Key (see above) 

• Uses Parameters to prompt the user for a polygon to define the location for the 
import, which is then used by each layer as part of the import process. 

• The chain will prompt the user, if they wish to clean the existing models.  

• The example imports three layers, the chain can edited to add more layers 

• Creates a new view called LINZ WFS 

• Then applies a mapfile and an Attribute Manipulator File to the imported dataset 

• Finally, creates labels using the Attribute Label Map file 
 
 
 
 

GIS_LINZ_LDS_WFS.chain is 
selected by hovering over the 
[USER_LIB] and selecting the file. 

 

Select <Edit> 
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Example Output 
 

 
 

More information about chain  

More information about the power of 12d chains, can be found using the links below 

 

Introduction to Chains 

Advanced Chains 

 

https://vimeo.com/763281924/473c9e1967
https://vimeo.com/762484080/847c86d8f1
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3.0 REST FEATURES 

Most council within NZ publish their Three Water and other assets within an GIS, and  most 
users would access this information via some sort of GIS viewing software. But getting this 
data out with (including attributes) could be problematic. 

 

The new REST features allow 12d users, to take a snap shot of the GIS data, including 
attributes.    

 

 GIS Rest Sources  

 

Below are a number of links to the different council GIS REST services. 

 

QLDC - https://gis.qldc.govt.nz/server/rest/services  

Auckland Council - https://services1.arcgis.com/n4yPwebTjJCmXB6W/arcgis/rest/services 

Christchurch - https://gis.ccc.govt.nz/arcgis/rest/services/CorporateData 

Canterbury Maps - https://gis.ecan.govt.nz/arcgis/rest/ 

Wellington - https://gis.wellingtonwater.co.nz/server1/rest/services/Councils 

 

 

 

 

 

 

 

 

 

 

 

 

Every REST service provider (Layer names and Attribute data) are 

different and will require different setup for each service. 

12d NZ has created a number of  EXAMPLE chains, these don’t cover 

evert assets type, therefore the user must building upon the supplied 

example. 

Every Layer is read into 12d on demand, so this could take some time        

depending on your Internet speed. 

 

https://gis.qldc.govt.nz/server/rest/services
https://services1.arcgis.com/n4yPwebTjJCmXB6W/arcgis/rest/services
https://gis.ccc.govt.nz/arcgis/rest/services/CorporateData
https://gis.ecan.govt.nz/arcgis/rest/
https://gis.wellingtonwater.co.nz/server1/rest/services/Councils


 

 

12d Model Help Manual 

GIS Import 

Page 14 

Via the toolbar, 12d NZ has created an overall chain that then calls region specific sub chain 
to import the required information from the GIS system. 

 

 

 

 

Like the LINZ Importation tool, the REST function requires a location for import. 

 

 

User need to activate the required 
region-specific chain. 
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The input, passed the location parameter into the different layer, creates a view called “REST 
Features”.  
 
Each Layer will be read into 12d one at a time, then added to the “REST Features “ view 
PRIOR to the applying the mapfile and label mapfile. 
 

 
 

Region Specific Sub-Chains  

 
As pointed out above, the overall REST chain applies a regional specific sub-chain, these 
chains are EXAMPLE only and user MUST undertake some QA to confirm that all of the 
required assets have been imported into 12d. 
 
In the CCC chain, each asset class is imported one at a time.  User can either edit an 
existing line within the chain or copy an existing line to read an new asset class. 
 
 

 
 
 

 

Some Councils GIS REST service have importation limit on the amount 

single asset classes that can be imported at one time.  

Auckland Council has a 2,000 limits. User might need to reduce the extents 

of the importation. 

 

 

 

URL to the REST 
service 

The drop down 
allows users to 
select the different 
assets at the highest 
level 

The drop down 
allows users to 
select different asset 
classes 

Name of model for 
the imported asset 
class, NOTE the 
RAW model refix, 
the chain will 
remove this model 
prefix 

Projection will be 
supplied by the chain 
parameter  
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This allows user’s to restrict, unwanted asset being read into 12d, ie removed or abandoned 
assets.  
 
Currently, 12d does not scan the attribute values prior to import the GIS layer, if users want 
to undertake Attribute filtering prior to importation, a workflow could be, to export the assets 

Polygon selection will 
be supplied by the 
chain parameter  

12d scans the data 
prior to import, in 
this example.  

Only assets with an 
attribute of 
“ServiceStatus” that 
has an value of 
equal to “In Service” 
will be imported into 
12d. 

Other values will 
not be imported, ie 
removed 
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class attributes to an CSV and then order the list based on the different attribute values and 
then enter the filters attribute values, like the above example. 
 

Mapfile 

GIS systems don’t use the concept of string names, therefore, GIS data must be filtered use 
the imported attributes and use the Att Key, before applying a string name. 

 

“$USER_LIB\MF_GIS_Import.mapfile” 

 

12d applies the imported attr 

 

 

 

 

 

 

 

Apply Attribute Manipulator File 

Users can apply an Attribute Manipulator file, if required, to manipulate data such as using 
the pipe diameter to create a pipe string. BUT, historic Three Water might not contain this 
information and the Attribute Manipulator file might fail to run. It is best to review the supplied 
dataset before creating an Attribute Manipulator file. 

Using the Att Key only 
objects that match the 
entered attribute values 
fill be assigned the 
string correct string 
name 
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Label Attribute Mapfile  

As each GIS system has different attribute names, 12d NZ has create an Attribute 
Manipulator file ( $USER_LIB\GIS_Attributes_12d.12dattmf)  which converts the attribute 
values into an attribute branch  called “12d” this allows the user to apply a common label 
attribute mapfile. 

 

 

 

 

 

Each GIS major systems 
have been split into different 
regions within the file  
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The chain the runs Attribute Label Mapfile ($USER_LIB\GIS_Pipe_Label.12dlf) to create the 
labels using the 12d attribute branch. 

 

 

Att Man file creates a new 
attribute branch called “12d”  

Full path to the required 
attribute to be labelled   

String Name for each asset 
to be labelled 
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4.0 WMTS 

WMTS services are useful if you want to make your cached map or image services available 
in an open, recognized way across different platforms and clients.  

 

Most GIS imagery is now suppled using the WMTS, such as the Linz Data Services or 
council GIS system. 

 

Selecting a Layer within LINZ Data Services Website 

 

Using the LINZ Data Service Website, the user has the option of viewing a single layer or all 
of the available layers  

 

 

 

 

 

 

 Select required LDS Layer to view 
more options 
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Unlike the WFS layers (details below) the WMTS layer are only saved 

within NZTM, therefore the location polygon needs to be within NZTM. 

Once imported the model can reprojected within 12d to the correct local 

circuit. 

 

 

The user can select a 
single layer or ALL the 
WFS layer that can be 
search within 12d 
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The user can select a 
single layer or ALL the 
layer’s that can be 
search within 12d 
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Note the set projection is NZTM 

GIS and Google Earth use a software 
option that allows for different imagery 
tiles to be shown at different scales, ie 
then the user scrolls in or out, different 
raster are shown 

This option is not supported within 12d, 
so the user can select the correct scale 
for the final output required 
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Import Tab 

 
 
 
 
 
 

 
 
 
 
 
 

There are a number of different Spatial Operators that have 
been defined within a GIS system, Section 8.8.5.1 of the Help 
guide goes into detail of the different options 

For Most users, selecting the “By Boundary” Operator will 
work in most situations. Ie import all the information on a layer 
that contained within a Boundary Polygon 
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Loading the Tile Images 

12d will prompt the user on the number of images that are to be imported into the project 
folder. 

Note the number of tiles increase as the imported scale decreases  

 

 

 

 

Reprojecting the WMTS Layer 

Once the raster has been imported into 12d, the user can then covert to local circuit using 
the flowing option 
 

Survey > Survey > Conversions/Transformations 

 

 
 
  
  

Enter the correct Coordinate system 
for the raster to be converted into. 

NOTE need to select Replace the 
existing data 
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4.1 WMS 

The option has mainly been replaced by GIS software with the WMTS option 

 

4.2 WFS 

Some inhouse or council GIS system will publish WFS which can be read into 12d. 

The user just needs a valid URL, otherwise this feature is exactly like the LINZ WFS.  
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NOTES:  

 



 

 

12d Model Help Manual 

GIS Import 

Page 28 

 


